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Sébastien Le Roux and Valeri Petkov

J. Appl. Cryst. (2010). 43, 181–185

Copyright c© International Union of Crystallography

Author(s) of this paper may load this reprint on their own web site or institutional repository provided that
this cover page is retained. Republication of this article or its storage in electronic databases other than as
specified above is not permitted without prior permission in writing from the IUCr.

For further information see http://journals.iucr.org/services/authorrights.html

Many research topics in condensed matter research, materials science and the life sci-
ences make use of crystallographic methods to study crystalline and non-crystalline mat-
ter with neutrons, X-rays and electrons. Articles published in the Journal of Applied Crys-
tallography focus on these methods and their use in identifying structural and diffusion-
controlled phase transformations, structure–property relationships, structural changes of
defects, interfaces and surfaces, etc. Developments of instrumentation and crystallo-
graphic apparatus, theory and interpretation, numerical analysis and other related sub-
jects are also covered. The journal is the primary place where crystallographic computer
program information is published.

Crystallography Journals Online is available from journals.iucr.org

J. Appl. Cryst. (2010). 43, 181–185 Le Roux and Petkov · ISAACS

http://journals.iucr.org/j/
http://dx.doi.org/10.1107/S0021889809051929
http://journals.iucr.org/services/authorrights.html
http://journals.iucr.org/j/
http://journals.iucr.org


computer programs

J. Appl. Cryst. (2010). 43, 181–185 doi:10.1107/S0021889809051929 181

Journal of

Applied
Crystallography

ISSN 0021-8898

Received 15 September 2009

Accepted 2 December 2009

# 2010 International Union of Crystallography

Printed in Singapore – all rights reserved

ISAACS – interactive structure analysis of
amorphous and crystalline systems
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ISAACS (interactive structure analysis of amorphous and crystalline systems) is

a cross-platform program developed to analyze the structural characteristics of

three-dimensional structure models built by computer simulations. The models

may have any degree of periodicity (i.e. crystallinity) and local symmetry. The

following structural information is computed from the models: total and partial

radial distribution functions and structure factors for X-ray or neutron

scattering, coordination numbers, bond-angle and near atomic neighbor

distributions, bond-valence sums, ring statistics, and spherical harmonics

invariants. The information may be visualized conveniently and stored for

further use.

1. Introduction

Detailed knowledge about the three-dimensional atomic scale

structure is a prerequisite to understanding and predicting properties

of materials. This knowledge is usually obtained by diffraction

experiments followed by computer simulations aimed at building

three-dimensional structure models that are consistent with the

diffraction data and all other structure-relevant information known

from alternative sources. However, once built the models are just a

set of coordinate triples for several tens, in the case of crystalline

materials, to several thousands, in the case of heavily disordered

materials, of atoms. Consequently, the models need to be analyzed

further so that important details of the atomic scale structure, such as

distribution of first atomic neighbors, bond angles and local

symmetry, are well understood. Unfortunately, few computer

programs exist that could perform the latter task. Here we describe a

computer program named ISAACS (interactive structure analysis of

amorphous and crystalline systems), designed as an intuitive and

user-friendly tool box for carrying out detailed analyses of three-

dimensional atomistic models of any degree of periodicity and local

symmetry. The periodicity may range from the infinite periodicity of

crystalline lattices to none, as with clusters. The symmetry may be as

high as in cubic crystals and as low as that of melts.

2. Programming framework

ISAACS (Fig. 1) is developed in C and Fortran90 and uses GTK+

(GTK, 2009) for the graphical user interface (GUI). The C part of the

code is used as a binding to wrap the GTK+ GUI over the Fortran90

core routines used for the calculations.

Separating the ISAACS GUI from the

Fortran90 routines makes the latter very

easy to re-implement in other programs.

Basically the Fortran90 routines are

controlled by the GUI with minor excep-

tions, where GTK+ functions are called from

Fortran90 routines to update a bar indicating

the progress of calculations.

2.1. Supported platforms

The GTK+ library is a highly portable

environment, which allows ISAACS to be a

cross-platform software. Microsoft Windows

(32 bits), Linux (32 and 64 bits) and Mac OS

X (Intel-based) versions of the program are

available.

2.2. The ISAACS project file format

ISAACS uses an intuitive format for a

project file (see Fig. 2), which contains all the

parameters needed to set up a calculation of
Figure 1
Visual overview of the ISAACS program.
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structural characteristics of a three-dimensional model. The format of

the file follows the XML coding (World Wide Web Consortium, 2009)

and allows the user to store detailed information about the model to

be analyzed: chemical composition, the chemical and physical prop-

erties of each atomic species (e.g. atomic weight and X-ray/neutron

scattering amplitudes), the size of the model box, the atomic coor-

dinate type (e.g. Cartesian or fractional), time series properties, and a

description of the bonding between atoms. The information is

provided by the user and may be re-used/modified during ISAACS

execution.

The .ipf file illustrated in Fig. 2 shows the parameters ISAACS

needs to perform an analysis of the three-dimensional structure

model of silica glass presented in Fig. 3.

In this particular example a file in ‘chem3d’ format (sio2.chem3d)

comprising the coordinates of 3000 atoms from a three-dimensional

structure model for silica glass is read by ISAACS. The corresponding

atomic number Z (Z = 8 for oxygen and Z = 14 silicon), atomic mass,

radius, and neutron and X-ray scattering amplitude are assigned to

each of the atoms from the model. The values of these parameters for

all atomic species from the periodic table are stored in ISAACS but

may be modified by the user if needed. The size of the model box in

terms of box edge lengths a, b and c and angles �, � and � are

provided by the user. Here the box is cubic and its edge is 35.662 Å in

length (see Fig. 2). ISAACS then generates a transformation matrix

of vectors to be used as an internal coordinate system. Finally, the

bond-length distances (e.g. O—O, Si—O and Si—Si) are specified by

the user.

3. Features

The main interface of the ISAACS program (Fig. 4a) gives access to

the following menus:
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Figure 2
Example of ISAACS project file (.ipf) in XML format, for glassy silica.

Figure 3
Three-dimensional structure model of silica glass generated by reverse Monte
Carlo simulations guided by synchrotron X-ray radiation data. The glass is a
continuous random network of Si and O atoms sitting, respectively, at the centers
and vertices of only corner sharing tetrahedral units.
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(i) The ‘Project’ menu (Fig. 4b) is used to read and write .ipf files

(Fig. 2) as well as to import/export coordinates of atoms from the

analyzed structure models (x3.1).
(ii) The ‘Edit’ menu (Fig. 4c) is used to define the properties of the

structural characteristics of a system to be studied.

(iii) The ‘Compute’ menu (Fig. 4d ) is used to run the calculations

(x3.2).
(iv) The ‘Help’ menu (Fig. 4e) is used to access the documentation

provided to help users.

3.1. Data inputs and outputs

The current version of ISAACS can import three-dimensional

structure models in four different formats:

(1) XYZ (Minnesota Supercomputer Center, 1993)

(2) multiple XYZ (Minnesota Supercomputer Center, 1993)

(3) Chem3D (CambridgeSoft, 2009)

(4) PDB (Protein Data Bank; Berman et al., 2000)

The coordinates of atoms from a three-dimensional model can be

in any of the widely used formats listed below:

(1) Cartesian

(2) Fractional with the center of the model box at (0, 0, 0)

(3) Fractional with one of the corners of the model box at (0, 0, 0)

ISAACS can output an already imported three-dimensional model

in XYZ or multiple XYZ structure formats (Minnesota Super-

computer Center, 1993) in any of the atomic coordinate formats (1)–

(3) .

3.2. What can be computed by ISAACS?

ISAACS can compute the following important structural char-

acteristics of a three-dimensional structure model:

(a) Radial distribution functions g(r) (RDFs) (Allen & Tildesley,

1987), including (i) total RDFs for neutrons and X-rays; (ii) partial

RDFs; and (iii) Bathia–Thornton RDFs (Salmon, 2007).

(b) Structure factors S(q) (Dove et al., 2002) including1 (i) total

structure factors S(q) for neutrons and X-rays; (ii) Faber–Ziman

(Faber & Ziman, 1965) partial S(q); (iii) Ashcroft–Langreth

(Ashcroft & Langreth, 1967a,b, 1968) partial S(q); and (iv) Bathia–

Thornton (Bhatia & Thornton, 1970) partial S(q).

In ISAACS the existence of a bond between particular atomic

species is determined by the user, who may supply appropriate bond-

length distances (see Fig. 2). An estimate for the bond-length

distances in a structure model may be made by looking at the first

maxima/minima of the respective partial atomic distribution

distances computed by ISAACS.

When atomic bonds in a model are defined properly other struc-

tural characteristics can be evaluated, as follows:

(c) Interatomic bond properties: (i) coordination numbers; (ii)

atomic near neighbor distribution; (iii) fraction of links between

tetrahedra; (iv) fraction of tetrahedral units; and (v) bond-length

distribution for the first coordination sphere.

(d ) Distribution of bond angles.
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Figure 4
(a) Main interface of the ISAACS program, with the (b) ‘Project’, (c) ‘Edit’, (d )
‘Compute’ and (e) ‘Help’ menus.

Figure 5
Results of the calculation of the radial distribution functions for a 3000-atom model
of silica glass by the ISAACS program: the interaction box (a) displays the
corresponding ISAACS menu options, while (b) shows the computed RDF in the
case of neutron scattering. The RDF exhibits a first sharp peak positioned at 1.6 Å,
which is the Si—O distance in well defined Si(O)4 tetrahedral units. The second
RDF peak, at 2.4 Å, reflects the correlations between O atoms sitting on the
vertices of those tetrahedra.

Figure 6
Results from the calculation of the angle distribution for a 3000-atom model of
silica glass by the ISAACS program: the figure represents the distribution of the
bond angles (O—Si—O) as computed and displayed by ISAACS. In SiO2 glass the
O—Si—O angle distribution peaks at about 109� as may be expected for
tetrahedral Si(O)4 units.

1 Structure factors can be computed by (i) Fourier transformation of the radial
distribution functions and/or (ii) using the Debye formalism (Dove et al.,
2002).
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(e) Distribution of dihedral angles.

( f ) Ring statistics, according to several definitions: (i) all closed

paths (no rules); (ii) King’s (1967) rings; (iii) shortest paths

(Guttman, 1990; Franzblau, 1991); (iv) primitive rings (Goetzke &

Klein, 1991; Yuan & Cormack, 2002) or irreducible (Wooten, 2002);

and (v) strong rings (Goetzke & Klein, 1991; Yuan & Cormack, 2002).

Also included are options for (vi) the possibility to look only for

ABAB rings and (vii) the possibility to exclude rings with homopolar

bonds (A—A or B—B) from the analysis. Ring statistics are

presented according to the RINGS method (Le Roux & Jund, 2010).

(g) Spherical harmonics invariant, Ql, as local symmetry identifiers

(Steinhardt et al., 1983): (i) average Ql for each chemical species and

(ii) average Ql for a user-specified structural unit.

(h) Bond-valence sums (CCP14, 2006; Brown & Altermatt, 1985;

Brown & Shannon, 1973): (i) average bond valence for each chemical

species and (ii) average bond valence for a user-specified structural

unit.

ISAACS also computes the mean square displacement (MSD) of

atoms, a dynamic property widely used in the analysis of molecular

dynamics simulations. In that case ISAACS can compute the

following quantities:

(i) MSD per atomic species.2

(j) Directional MSD (x, y, z, xy, xz, yz).2

(k) Drift of the center of mass (x, y, z).

(l ) Correction of the drift of the center of mass (x, y, z).

3.3. General features of the program

A set of structural characteristics for a three-dimensional model of

silica glass computed by ISAACS is shown (see Figs. 5–8), as an

example of the program output. The model has been constructed by

reverse Monte Carlo simulations guided by high-energy X-ray

diffraction data for silica glass (Petkov et al., 2000). It consists of 2000

O and 1000 Si atoms inside a box of dimensions 35.6621 Å. To

compute each of the characteristics shown below the relevant dialog/

menu boxes have been used to set up the values of the program

parameters required to run a structure analysis. For example, Fig. 9

presents the dialog boxes used to control the calculations of the radial

distribution function (Fig. 9a) and the ring statistics (Fig. 9b) for silica

glass. Once the three-dimensional structure is read and validated by

ISAACS the only parameter required to compute the RDF is the

number of steps in real space, �r (Fig. 9a). In the second case (Fig. 9b)
a few more control parameters (the definition of a ring, the chemical

species used to initiate the search, the maximum size of a ring, the

maximum number of rings per node and a description of the chemical

bonds) are needed.

ISAACS requires users to supply control parameters to guide the

computation sequence. Information about these parameters can be

obtained through a help button in the dialog box (Fig. 9) or through

the help menu of the main window of the program (Fig. 4e).

3.4. Visualization of the results of the calculations

When a particular structural characteristic is computed it can be

directly displayed in the main ISAACS windows (Fig. 4). In addition

the visualization mode of most of the computed characteristics can be
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Figure 7
Results of the calculation of the spherical harmonics as local order parameters for a
3000-atom model of silica glass by the ISAACS program: (a) average Ql computed
for the Si(O4) environments (distorted tetrahedra) in glassy SiO2, compared with
(b) average Ql computed for the Si(O4) environments (ideal tetrahedra) in
crystalline quartz-�. The two sets of Ql values follow a similar trend, showing the
similarity between the structural units in crystalline and glassy SiO2. The
differences are mostly quantitative and are due to the fact that the Si—O
tetrahedra are somewhat distorted in the glass.

Figure 8
Ring statistics for silica glass as computed by ISAACS. These results present the
average number of rings per atom in the simulation box for a maximum ring size
fixed to 20 atoms. Note that if the number of rings is normalized per Si(O4) unit and
not per atom the ‘ring size’ will drop by a factor of two, i.e. the distribution will peak
around rings made of seven Si(O4) units.

2 Computation performed with a correlation of all the properties as well as
without correlation (step by step).
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controlled via interactive menus such as the one presented in Fig. 5(a).

When a button in an interaction menu is activated (Fig. 5a) the

corresponding result is instantaneously displayed as a smooth curve

or a histogram (Figs. 5b, 6, 7 and 8) depending on the nature of the

computed structural characteristic.

3.5. Saving the data

Results computed by ISAACS can be easily saved using the stan-

dard copy and paste method (for the results presented in the main

ISAACS window) or using the ‘Data’ menu (Fig. 8). The user can also

export data either in a raw ASCII format (simple two-column file

with x and y) or in the Xmgrace format, which can be used

immediately in the Grace plotting tool (http://plasma-gate.

weizmann.ac.il/Grace/) for a further analysis.

Fig. 10 shows the data of Fig. 8 as exported and plotted by the

Xmgrace export filter of ISAACS.

4. Distribution and documentation

The ISAACS program is licensed under the terms of the GNU

General Public Licence version 3 (Free Software Foundation, 2007).

ISAACS binaries and sources are available for download from the

following web sites: http://www.phy.cmich.edu/people/petkov/isaacs/

and http://isaacs.sourceforge.net/.

The web sites dedicated to the ISAACS program also provide a

theoretical background of the structural analysis, model examples, an

82 page user manual and online help on the utilization of the

program.

Work on this project was supported by the NSF Mixed Network

Former Effect – MNFE project DMR grant No. 0710564.
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Figure 9
Dialog boxes controlling (a) the calculation of radial distribution functions and (b)
ring statistics in the ISAACS program.

Figure 10
Illustration of the utilization of the Xmgrace export filter in the ISAACS program.
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